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1 Important Installation Information 
 

1.1 System Requirements for HELiOS 
For the installation of HELiOS you may use any hardware possessing current drivers for 
the operating systems used. Please note, for instance, that the graphics card drivers 
need to support the complete OpenGL instruction set.   

» Hardware requirements: 

 Pentium 4 compatible processor with SSE2 support 

 1 GB RAM 

» Supported operating systems: 

 Windows XP (with current service pack and security patches) 

 Windows 7 (with current service pack and security patches)  

»  Supported database systems:  

 Microsoft SQL Server 2000 

 Microsoft SQL Server 2005  

 Oracle Database Server 8i 

 Oracle Database Server 9i 

 Oracle Database Server 10g 

» Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to 
be installed on the computer before HELiOS 2012 can be used; these packages are 
installed by the HELiOS installer if necessary. 

» If you want to work with HELiOS, one of these database systems needs to be 
available and prepared for HELiOS. Installation instructions (in .pdf format) and 
appropriate implementation of the server system can be found in the Readme 
directory of the HELiOS Installation DVD.  

» Current information on system requirements can also be found on the Internet at 
www.helios.isdgroup.eu > Service & Support > FAQ. 
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1.2 Hardware Requirements License Server 
 

Processor (CPU): x86 Processor for 32-Bit / x86-64 Processor for 64-Bit 

Recommended: 2 GHz Processor 

RAM: Minimum: 1 GB  

Recommended: 2 GB (with SQL Server > 3 GB ) 

Hard disk: 1.2 GB free disk space 

Operating System 
(Server) 

Windows Server 2003 (32 & 64-Bit) 

Windows Server 2008 (32 & 64-Bit) 

Windows Server 2008 R2 (64-Bit) 

Operating System  
(Client) 

Windows XP (32 & 64-Bit)  

Windows Vista (32 & 64-Bit) 

Windows 7 (32 & 64-Bit) 

IP/MAC Adress A static IP address is required for an error-free 
operation of the license server. 

For virtual servers a static MAC address needs to be 
available. 

 

 A license server program need not run on a file server system or any specific 
hardware server. Any computer that meets the requirements is acceptable. 

  



Important Installation Information 

10 UNLIMITED PERFORMANCE 

1.3 Hardware Requirements Vault Server 
 

Processor (CPU): Pentium III-compatible processor, Minimum: 1,0 GHz 

RAM: Minimum: 1 GB, Recommended: 4 GB or more 

Graphics Card: VGA (no special requirements) 

Hard disk: For software: 100 MB 

For user data: Depending on the amount of data to be 
expected, plus backup memory of >= 100%  

(distribution over several volumes/drives possible, 
redundant array of independent disks (RAID) for primary 
user data recommended) 

Operating system 
(virtual servers also 
possible): 

 

Windows XP SP3 Professional 
Windows XP SP2 x64 Professional 

Windows 7 Professional 
Windows 7 x64 Professional 

Windows Server 2003 SP2 
Windows Server 2003 SP2 x64  

Windows Server 2003 R2 SP2 
Windows Server 2003 R2 SP2 x64 

Windows Server 2008 SP2 
Windows Server 2008 SP2 x64  

Windows Server 2008 R2 x64 
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1.4  System Requirements for the HELiOS Internet Server 
» Microsoft Internet Information Services, Version 7 or higher, with CGI support. This is 

part of Windows Server 2008/Windows 7, but needs to be installed separately.   

» Installed HELiOS Version. 
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2 Installation 
The DVD contains the installation files for:  

» HELiOS  

» Online Help 

» Vault Server 

» License Server 

» HELiOS Plot Management (Server Component Spooler) 

» HELiOS Internet Server 

The HELiOS DVD has been developed for Windows operating systems. When inserting 
the DVD, an installation wizard is started automatically.  

 

 The HELiOS version needs to be installed on the hard disk of the computer; it is not 
possible to start the program from the DVD. 
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2.1 Installing HELiOS 
To install HELiOS, start Windows. If Windows is already open, close all other 
applications. Insert the HELiOS DVD in your DVD drive. The installation wizard will be 
started automatically. Follow the instructions on the screen. 

 

Click the HELiOS button to start the installation of the HELiOS Desktop.  

Microsoft .NET Framework 4.0 or higher and Visual C++ Runtime Libraries need to be 
installed on the computer before HELiOS 2012 can be used; these packages will be 
installed now if required.   
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Select an installation directory.  

 

Please read the Notes on Hardware Exchange carefully.  

 

Notes on Hardware Exchange 

If you use local HiCAD/HELiOS/HELiCON licenses and want to exchange any hardware 
components, modify the partitioning of, or re-install the operating system, you need to 
revoke the existing license on the HiCAD workstation first, and request, using the new 
hardware or modified configuration, a new license key (further information on the 
procedure can be found in the software documentation). 

If a revocation is technically possible, but will not be performed, the ISD reserves the 
right to charge costs in an appropriate amount for the reissuing of the license. If the 
license will not be revoked, or if such revocation is no longer technically possible, the 
ISD may request proof that the unrevoked license is no longer utilisable; in case of 
failure to produce such proof, the ISD reserves the right to refuse the transfer of the 
license to a new hardware. 

 

Accept the notes to continue with the installation. 



Installation 

16 UNLIMITED PERFORMANCE 

 

You can now start with the installation or modify the Extended Settings, e.g. for HELiOS. 

 

In case of a new installation you can specify an arbitrary name for the system data 
source. In case of an update, the existing data source will be offered. User and 
Password will be identical with the ODBC login. 

If you want to process your print jobs via the ISD Plot Management, you need to install 
one PrintClient on each workstation. In the Server field, enter the network name of the 
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computer on which the Spooler is installed. The Spooler collects the print jobs and 
processes them, taking your settings into account.  

 

You need the License Administration Tools for the installation of server licenses.  

Click Save to save the Extended Settings to an INI file. If you place the INI file in the 
installation directory when installing server licenses, the settings will be applied.  

 

If you leave the Extended Settings dialogue with OK, the installation will be started. 
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After successful installation, you will find the link to the HELiOS Desktop on the desktop 
for program launch.   
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2.2 Installing the Online Help  
The Online Help is available locally (status of the date of installation DVD creation) and 
on the Internet (regularly updated) at help.isdgroup.com. Both versions of the Help can 
be directly started from HELiOS. Please note that corresponding login data are required 
to access the Internet version of the Help.   

Start Windows to install the Help. If Windows is already open, close all other 
applications. Insert the DVD in the drive, which automatically starts the installation 
wizard.  

 

Click the HELiOS Help button. 

 

http://www.help.isdgroup.com/
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Specify the installation directory for HELiOS. 
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After successful installation, the Help can be found in the program folder and can be 
called via HELiOS. 
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2.3 Installing the Vault Server 
Start Windows to install the Vault Server. If Windows is already open, close all other 
applications. Insert the DVD in the DVD drive, which automatically starts the installation 
wizard.  

 

 

Click the Vault Server button. 
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Specify the installation directory of the Vault Server. 

 

Give the Vault Server a name, e.g. the name of your company, plus the location of your 
company. This name will be shown, for example, when you connect to the Vault Server 
from the Vault Client.  



Installation 

24 UNLIMITED PERFORMANCE 

 

The Vault Server renames all documents that are managed in the database (e.g. SZA, 
DOC, XLS, …) to *.VDF. These VDF files are saved to the Document directory.  

The files stored in the Management directory contain the assignments of the VDF file 
names to the “original file names”.   

Log files (*.LOG) are saved to the Log directory. They record each access to the VDF 
files. 

Enter the name of the log file in the Log file name field. The name of the Vault Server 
would also be possible here. If the log file exceeds a certain length, it will be cut down 
and suffixed by the current date.  
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Click the Install button. 

 

Click Finish to complete the installation of the Vault Server. You can now install further 
components offered in the selection mask if desired. 
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2.4 Installing the HELiOS Spooler  
Start Windows to install the components of the plot management. If Windows is already 
open, close all other applications. Insert the DVD in the DVD drive, which automatically 
starts the installation wizard.   

 

 If you use Windows XP, Service Pack 3 is required for the Spooler.  

 

 

Click the HELiOS Spooler button.  
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Specify the installation directory for the software. 

 

Specify a default directory for the management of the print files.  
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After successful installation, the HELiOS Spooler will be located in the program folder.  
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2.5 Installation of HELiOS Internet Server 
Start Windows to install the HELiOS Internet Server, first start Windwos. If Windows is 
already open, close all other applications. Insert the DVD in the DVD drive, which 
automatically starts the installation wizard.  

 

 If you use Windows XP, Service Pack 3 is required for the Spooler. 

 

 

 

Click the HELiOS Internet Server button. 
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Specify the installation directory for the software. 

 

Enter the Port number. Default value is 80. If you want the HELiOS Internet Server to 
run on a different Port (because Port 80 is already being used for a different website or 
application), enter this Port here and click Next.  
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Start the installation. 

After successful installation the HELiOS Internet Server will be located in the program 
folder. 
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3 Important Notes on Updates 
3.1 HELiOS Update 
When making a HELiOS update, the update start mask shows you the HELiOS 
subversion, which needs to match the existing database. If this is not the case, only an 
error message will appear when you start HiCAD/HELiOS. To update the database 
schema, use the program HeliosDbUpdate.exe. Please note the following: 

 

Important 

When making a HELiOS Update, an update of the database schema might be 
necessary as well. If the database schema requires an update, you can no longer 
access the database with older HELiOS versions. Therefore, all workstations 
accessing the database need to be readjusted accordingly at the same time.. 

It is mandatory to make a database backup before the update, as the update can 
normally only be reverted by importing the backup. 

The responsible administrator should always be informed prior to the update, in order 
to enable a coordinated conversion. 

After a HELiOS update from Version 2008 (or older) to Version 2012, the database must 
be additionally converted from the ANSI to the Unicode character set.  
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3.1.1 Perform Update  
The update can be performed from any HELiOS/HiCAD workstation with a database 
connection. 

The HeliosDbUpdate.exe program is used for this purpose. It can be started via the 
Windows Explorer, or similar programs, from the EXE directory of the HELiOS/HiCAD 
installation. 

The following mask will be displayed after starting the program: 

 

Click the Update database… button to start the update. The following message will be 
displayed: 

 

If you confirm this message with OK, another confirmation prompt is displayed: 
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Confirm with Yes to perform the update. After a successful update, the following 
message will be displayed: 

 

A further check can be carried out by clicking the Re-determine button in the main 
window of the program, after confirming this message with OK. 

After a successful update, software version and database version must be identical. 
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3.2 Important Notes on Updates to Version 2012 
3.2.1 Licensing 
Version 2012 can be obtained either on an installation medium (DVD), or via download 
from the ISD Homepage.  

As of HELiOS version 2010 the activation takes place via a software license. The 
activation is no longer linked to a dongle, but directly to the hardware of a server or an 
individual workstation. 

If you use a Server License, you need to update the License Server Software and the 
License Management Tools; if you use Local Licenses, you need to install the new 
version.  

Normally, licenses for older HELiOS versions must be revoked first.  

After confirmation of the revocation you will receive one or several Entitlement IDs 
enabling you, in combination with your E-Mail address and your Password, to activate 
the new licenses (see 4.3). 

Licenses can be deactivated at any time, without having to contact the ISD Group, via 
the License Activator in the License Manager, i.e. they can be temporarily stored on the 
Server of the ISD. For this you require your Entitlement ID, your E-mail address and 
your Password. The activation can then be performed on any other computer, i.e. the 
licenses can be transferred to this computer. For Server Licenses this procedure can 
only be performed for the entire license License Pool.  

 After updating HELiOS (from Version 2008 or older) to Version 2012, you must 
return your workstation dongle to the ISD. You can then no longer use any older 
HELiOS versions. 
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3.2.2  Perform HELiOS Installation 
The installation of version 2012 can be carried out by a technician of the ISD or by the 
customer. In this context, please note the following recommendations by the ISD: 

» HELiOS 

 Update of version 2010 to version 2012: An installation by the ISD is 
recommended. 

 Update of version 2008 (or older) to version 2012: An installation by the ISD is 
recommended. The update installation includes a data conversion to UNICODE 
format. 

» 3rd party CAD with HELiOS 

 Update of version 2010 (or older) to version 2012: An installation by the ISD is 
recommended. 
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4 License Installation Guide (Version 2012) 
HELiOS can be activated via three license types:  

» Network licenses 

» Standalone licenses (local licenses) 

» Commuter licenses 

 To start the Online Help for the Licence Manager call the 
LICENSEMANAGER.HTML file in the folder Docu\tools\Licensemanager.  

 

4.1 General Information about Licensing 
 

4.1.1 Local (Workstation-Specific) Licensing 
If you choose local licensing, the activation will be directly locked to the hardware of the 
workstation on which your HELiOS program is installed.  

The ISD will send you an E-mail containing the Entitlement ID for local licenses 
(standalone).  This ID will be required for the activation and deactivation of the licenses 
and software modules. Please keep the Entitlement ID! Without this ID you cannot 
activate or deactivate any licenses! In case of a defect, no reconstruction of licenses will 
be possible without the Entitlement ID!  After installing HELiOS, you activate the licenses 
by means of the License Activator in the ISD License Manager. 
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4.1.2  Network (Server-Controlled) Licensing 
If you choose network (server-controlled) licensing, the license will be directly locked to 
the hardware of the server that centrally manages the HELiOS licenses. These licenses 
can be used on any workstation in your network that is connected to this server.  

The ISD will send you an E-mail containing the Entitlement ID. If you have several 
network servers, e.g. at several locations, you will receive one Entitlement ID for each 
network server. This ID will be required for the activation and deactivation of the 
licenses and software modules. Please keep the Entitlement ID! Without this ID you 
cannot activate or deactivate any licenses! In case of a defect, no reconstruction of 
licenses will be possible without the Entitlement ID!  You activate/deactivate the network 
licenses by means of the License Activator in the ISD License Manager.  

Individual licenses can be checked out from the server and locked to a workstation 
within or outside the network (so-called “commuter licenses”). This enables you to 
continue working at a different location, without being connected to the license server 
(unless your HELiOS installation requires a connection to a database server).  For this 
purpose you define a specific period during which you want the license to be available 
on a selected workstation. For this period, this license will be blocked on the license 
server. After expiry of this period, the license will be made available on the license 
server again. It is also possible to manually return this license to the server before expiry 
of the defined period, if the workstation is connected to the server. Licenses for one 
workstation can be checked out for at least one day, with the counting beginning at 
1:00 AM on the day following the checkout date.   

If you want to replace/exchange your license server, you need to deactivate all licenses 
first. 

 A static IP address is required for correct operation of the license server! 
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4.1.3 Practical Examples of Network Licensing 

» Let us assume that three licenses have been activated on your server. Monday 
morning (11.00 am) you suddenly need to see a customer for design tasks, and you 
know that you will still be on-site at the customer’s facility on Tuesday. You therefore 
check out a license for 24 hours on 11.00 am. This means that you can use this 
license until Tuesday night, 11.59 pm, from your mobile workplace. After expiration 
of this period, the license is automatically made available again on the server. If you 
manage to finish your work on Tuesday at midday, you can go back to your office 
and return the license to the server somewhat earlier. 

» Similar situation as the one described above, with the difference that you are not in 
your office on Monday, 11.00 am. In such cases you can generate a hardware ID, 
enabling your colleagues in the office to check out a license for you. This license is 
sent to you by E-mail and can then be activated. In contrast to the previous example, 
this license is exclusively available to you for a fixed period of time and cannot be 
returned to the server before expiration of this period. 

 

 For computers possessing a WLAN card: Please switch off the WLAN card before 
executing the Get Identification Code command!   

If you activate a license while the WLAN card is switched on, this license will only be valid 
and visible when the WLAN card is switched on. If, however, the license is activated while 
the WLAN card is switched off, the license will always be valid, no matter whether the WLAN 
card is switched on or off. As of Version 1701 the activation status of the WLAN card will no 
longer be relevant. 

 

4.2 Network Licenses 
To be able to use network licenses, a License Server needs to be installed on a 
computer without HELiOS.  

The license server enforces and manages licensing in multi-user environment. It keeps 
track of all the licenses and handles requests from network users who want to run a 
HELiOS application, granting authorization to the requesters, or denying requests if all 
licenses are in use.  
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The license server must not be installed on the same computer on which an ISD 
software product (HiCAD, HELiOS) is installed, as both product share system data 
concerning the licensing information. Formerly, such parallel installations of license 
servers and ISD products were performed in cases where a customer occasionally 
wanted to transfer the license to another computer (Remote Commuter License). As of 
Version 1700 such scenarios can be realised in a much more convenient manner with a 
new licensing procedure.    

 

 Please note:   

 As of Version 1700, parallel installations of license servers and ISD products (i.e. on 
the same computer) are no longer covered by the warranty. The ISD group advises 
you strongly not to perform such installations. 

 A static IP address is required for a correct operation of the License Server! 
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4.2.1 Server Installation 
The installation of the SafeNet License Server takes place from the HELiOS DVD. Start 
Windows and insert the DVD in the DVD drive of your computer. The installation wizard 
will be displayed.  

 

Start the installation of the SafeNet License Server.  
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License Installation Guide (Version 2012) 

46 UNLIMITED PERFORMANCE 

After successful installation you will find the Server (Sentinel RMS License Manager) 
under Services. From here you can also start and end the License Server.  

 

 

 

 

4.2.2 Client Configuration 
To ensure that the HELiOS Client finds the correct License Server, an environment 
variable LSFORCEHOST should be set on each Client using network licenses. The value 
HOSTNAME, respectively the IP address of the License Server is assigned to the 
variable. 
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4.3 Licensing via Entitlement ID (License Activator) 
Thanks to the enhanced ISD License Manager 2.0 the communication between the 
customer and the ISD could be facilitated significantly.  

 

4.3.1 AutoRequest Licenses  
When acquiring a HELiOS license, you will obtain one Entitlement ID for local licenses 
(Standalone) and another one for network licenses (Network). If you have several 
network servers, e.g. at different locations, you will obtain one Entitlement ID for each 
network server. These numbers will be required for the activation and deactivation of 
the licenses and the software modules.   

 

 

 Please keep the Entitlement ID! Without this number you cannot activate or 
deactivate licenses. In case of a system crash a reconstruction of the licenses cannot take 
place without the Entitlement ID! 
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After installing HiCAD/HELiOS you can find the program in the Windows Start menu at 
ISD Software und Systeme > Administration. Please note that for the execution of 
some functions, administrator rights are required.  

The range of functions of the ISD License Manager depends on the activation of the 
License Administration Tools option. The information about this setting is entered in the 
Registry and can also be changed there subsequently if desired (please contact the 
Hotline).   
 

 To activate/deactivate Network Licenses, always start the ISD License Manager (x32 
Server) via the Windows Start menu: Select Start > All programs > ISD Software und 
Systeme GmbH > Administration. 

 

Activate the License Activator tab and enter the Entitlement ID, your E-mail address 
and your Password. New customers obtain their password from the ISD Hotline. With 
this password you can also access the Download Area.  

 

After entering the data, click Login. The ISD License Manager 2.0 connects to the ISD 
License Server and the acquired licenses will be displayed.  

This process may take several minutes. You can then activate the licenses. 
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4.3.2 Activate Licenses 
After successful login, the number of available licenses and the number of acquired 
licenses are indicated next to each module. Select the modules to be activated and click 
Activate to start the activation. For Server Licenses the modules are already pre-
selected! 

 

After successful activation a message showing you that all licenses have been 
successfully activated will be displayed:  

 

You can then log out and start working with the HELiOS modules. 

For Network Licenses, all modules will always be activated or deactivated (for further 
information about the operation of the License Manager, please read the Online Help for 
the License Manager. 

In addition, you will receive an E-mail informing you about the activated modules.  
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4.3.3 Deactivate Licenses  
A deactivation of licenses for modules will be required in the following situations:  

» Exchange of hardware or changing of hard disk partitioning 

» Update of the operating system (e.g. from Windows XP to Windows 7)  
For updates within one version no deactivation will be required. 

» Transfer of local modules from one workstation to another 

» Acquisition of further modules, or return of hired licenses 

» Switch from local licenses to network licenses 

Please note the following: All workstations with modules having the same Entitlement ID 
need to be deactivated completely before a redistribution of the module licenses can 
take place. 

After starting the ISD License Manager 2.0 the activated modules will be highlighted in a 
different colour. Click the Deactivate button to revoke the activation of the modules.   

 

A selection is not possible, as you need to deactivate all modules, no matter whether 
local licenses or network licenses.  
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 The deactivation must not be disrupted, e.g. by a logout or the closing of ISD 
License Manager 2.0! 

 

After successful deactivation the following message will be displayed:  

 

 

4.3.4 Trial Licenses  
If you select Display trial licenses after logging in, you will be also shown, besides all 
trial licenses with a limited period of validity, all purchasable licenses which are not 
simultaneously available as trail licenses.  

 

4.3.5 Reconstruction of Licenses  
As all licenses are stored on the ISD Server, you can, in case of an interrupted 
connection or an accidental deletion of licenses, restore all licenses by logging in with 
your Entitlement ID. The restoring will only function if the hardware was not changed 
(see 4.2.3.3 Deactivate Licenses). 

 

4.3.6 Notes Regarding the Use of Mobile Computers (Laptops) 
If you use a computer with WLAN card, Please make sure that the WLAN card will be 
either always switched on, or always switched off. As of Version 1701 the activation 
status of the WLAN card will no longer be relevant. 
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4.4 Commuter Licenses 
Commuter licenses enable you to use network licenses even if the workstation is not 
connected to the Server. There are two ways of receiving commuter licenses: 

» Via direct checkout from the License Server 

» Via checkout from License Server, without network connection 

 

 To activate/deactivate Network Licenses, Network Licenses always start the ISD 
License Manager (x32 Server) via the Windows Start menu: Select Start > All programs > 
ISD Software und Systeme GmbH > Administration.  

 

4.4.1 Direct Checkout from License Server 
Start the ISD License Manager (x32 Server) application (while a connection to the 
Server still exists). Switch to the Commuter License tab.  
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If you have set the system environment variable LSFORCEHOST, the entered License 
Server is displayed at start-up as pre-selection. Use the Search network button to 
automatically search for License Servers.  

Expand the tree structure of the found Server by a click on the “+”-sign. The result 
looks as follows:  

 

 

Select the required licenses by activating the corresponding checkboxes on the left 
hand side. On the right hand side, information on the selected license is displayed.  

In the Commuter license: Validity in days field, you enter the number of days that you 
want the commuter licenses to remain checked out from the Server. The maximum 
number of days is 60. By default (or if a “0” is entered), the value is set to 1.  

 

 For reasons of safety you should check out the licenses only for the required period! 
If a commuter license is lost, e.g. because of theft or a defect of the client computer, the 
license on the Server cannot be used any more before expiry of this date! 
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After entering the expiry date for the commuter licenses, activate the Update licenses 
button. 

 

Commuter licenses are checked out from the Server. 
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All selected licenses are now checked out from the Server and you possess all rights on 
your computer for the specified validity period for the commuter licenses. This means 
that you are enabled to work network-independent. The checked out licenses are no 
longer available to the other computers on the net.  

You can however also return the commuter licenses before their expiry date. To do this, 
you need to deactivate the checkboxes on the left hand side and click the Update 
licenses button. All licenses are now made available on the Server and locked on your 
computer, i.e. you can now only use HELiOS if there is a connection to the License 
Server. The licenses made available again can now also be used from other 
workstations. 
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4.4.2 Checkout from License Server, Without Network Connection 
Commuter licenses can also be drawn from the License Server without an existing 
network connection.  

 

 Please note that administrator rights are required.  
Commuter licenses checked out in this way cannot be returned to the License Server! This 
means that the commuter licenses that have been checked out from the Server are only 
(automatically) made available again after their expiry date. 

 

Several steps are required for this, by the administrator having a network connection to 
the License Server, as well as by the Client having no network connection to the License 
Server.  

The Client starts the ISD License Manager tool, switches to the Remote Locking Code 
tab and sends the generated character set to the administrator (via E-mail or over the 
phone). 
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The administrator starts the ISD License Manager (x32 Server) and switches to the 
Commuter License tab. The License Server is selected, and the required licenses 
(modules) are activated in the left window. To checkout a remote commuter license the 
administrator now needs to activate the Check out authorisation for remote computer 
checkbox. 

 

A click on the Update licenses button opens a new dialogue window, in which the 
administrator enters the character set received from the Client.  
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After selecting OK, another dialogue opens, in which you enter the target path and the 
file name for the licenses to be swapped out.  

 

 

Click OK to check out the commuter licenses from the License Server and swap them 
out to a file, e.g. RemoteLicCode.lic. 
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The successful checkout will be confirmed. The administrator then sends the file 
RemoteLicCode.lic to the Client.   

After receiving the file with the commuter licenses, the Client starts the ISD License 
Manager (x32 Server) again and activates the Install Remote Authorisation Code tab. 
Here the received commuter licenses can be installed directly via file selection or via 
copying of the file contents.  

 

Click the Install... button to install the commuter licenses on the Client.  
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After successful installation, switch to the License Info tab. Press the F5 (Update) key 
on your keyboard. You are now informed which licenses are installed locally on the 
computer.  

 

 

4.5 License Configuration HELiOS 
Some cases may require the use of only certain specific licences on a computer. 
Example: On the License Server, HELiOS and Plot Manager licences are available. On 
one Client, HELiOS is to be started, on another Client, the HELiOS Plotmaanager. If the 
selected license is no longer available, an application start is no longer possible.  

 

 If there are several basic modules in a standalone (workstation) license (to which 
also the Commuter Licenses belong), it is mandatory to make a pre-configuration and save 
it as workstation configuration.  
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On the HELiOS Configuration tab of the ISD License Manager (x32 Server) tool you 
have the option to save a workstation or user configuration for individual Clients.  

» Save as workstation configuration: This configuration will be saved for all users of 
this computer. When HELiOS is started, the selection window is no longer displayed 
(administrator rights are required for this).  

» Save as user configuration: This configuration is only saved for the current user. 
When HELiOS is started, the selection window with the saved configuration is always 
displayed.  

These licence configurations apply to network licenses and standalone (workstation) 
licenses.  
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4.6 Important Softlock/Hardlock Information 
When using the softlock/hardlocks as selector for the license file, please note that for 
system-inherent reasons the date must not be reset! Such resetting causes a blocking of 
the softlock/hardlock that can only be revoked by the ISD by means of a re-
programming. In such cases, we would have to charge you the costs of this 
unnecessary additional work. 

A change of the system time is possible, as long as it is not date-comprehensive. 

If you deem such date conversion absolutely necessary, please inform our staff on the 
hotline in good time. 

 

ISD Software und Systeme GmbH 

Phone: 0049 - 231 / 97 93 - 166 

Fax: 0049 - 231 / 97 93 - 101 

Mailto: hotline@isdgroup.de 

 

 IMPORTANT:  If you have a 64Bit version of HELiOS, the hardlock can no longer be 
used as license file selector due to missing driver support! 
 

4.7 Theft of a Workstation 
The user is responsible for appropriately insuring the HELiOS workstations against theft. 
If desired, we can tell you the reinstatement value of your software. If a workstation is 
stolen, you will need a new license. In such cases, please send us the police report of 
the theft first. We will then provide you with a license for a limited period of time, and 
submit an offer for a new license to you. The ISD will send you the new license after 
clarification of the case with your insurance and receipt of your payment for the license 
fee. 

mailto:hotline@isdgroup.de


Licenses Installation Guide (Version 2011) 

   63 

5 Licenses Installation Guide (Version 2011) 
As of HELiOS 2012, the licensing procedure should only be performed as described 
in Paragraph 4.  

For compatibility reasons, the following paragraph describes the procedure that is 
applied to Version 2011 and differs from the new procedure. 

 

5.1 Generate Identification Code and Send to ISD 
To generate the identification code, activate the Windows Start menu and select All 
Programs > ISD Software und Systeme > Administration > ISD License Manager (x32 
Server).  

 

 For computers possessing a WLAN card: Please switch off the WLAN card before 
executing the Get Identification Code command!   
If you activate a license while the WLAN card is switched on, this license will only be valid 
and visible when the WLAN card is switched on. If, however, the license is activated while 
the WLAN card is switched off, the license will always be valid, no matter whether the WLAN 
card is switched on or off. As of Version 1701 the activation status of the WLAN card will no 
longer be relevant. 

 

 



Licenses Installation Guide (Version 2011) 

64 UNLIMITED PERFORMANCE 

 

On the first tab you will find all information required for the generation of a new license. 
Click the Send button to automatically generate an E-mail with all necessary 
information. The E-mail will be opened with your standard E-mail program, enabling you 
to add your own message if desired. Alternatively, you can save these data to a text file 
and e-mail them to ISD Software und Systeme GmbH.  

You can also send the Selector and Code keys back to ISD Software und Systeme 
GmbH by post. Please note however that this procedure will delay the licensing.  

Based on the keys, a license for your computer will be generated and e-mailed to you.  

You will receive from the ISD Software und Systeme GmbH a self-executing license file 
(when it is sent by E-mail, the name of the file is [filename].ex_ ; it needs to be renamed 
to [filename].exe before execution). Double-click to execute the license file. Please note 
that administrator rights are required for this.  
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After successful unpacking, the License Server is re-started automatically.  

Use the License Server Monitor tool to check the installed files.  

 

 

 

Expand the tree structure of the Subnet Servers entry to display all License Servers on 
your network.  
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Then expand the tree structure of the installed Server (test-server2003.int.isdcad.de). 
All licenses installed and managed on the License Server are displayed.  
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5.2 Local Licenses 
Local licenses are generated for a particular computer. To do this, activate the Windows 
Start menu and select All Programs > ISD Software und Systeme > Administration > 
ISD License Manager (x32 Server). 

 

 

 

Click the Send button to automatically generate an E-mail with all necessary 
information. The E-mail will be opened with your standard E-mail program, enabling you 
to add your own message if desired. Alternatively, you can save these data to a text file 
and e-mail them to ISD Software und Systeme GmbH.  

You can also send the Selector and Code keys back to ISD Software und Systeme 
GmbH by post. Please note however that the sending by E-mail is significantly faster.  

Based on the keys, a license for your computer will be generated and e-mailed to you.  

You will receive from the ISD Software und Systeme GmbH a self-executing license file 
(when it is sent by E-mail, the name of the file is [filename].ex_ ; it needs to be renamed 
to [filename].exe before execution). Double-click to execute the license file. Please note 
that administrator rights are required for this. 
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The licenses are now unpacked and activated. After successful installation, the local 
licenses can be viewed on the License Info tab of the ISD License Manager (x32 
Server).  

 

 

 Press the F5 key to update the list of licenses. 
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5.3 Revoke Network Licence for Hardware Component 
Exchange 

If you want to use a different computer as license server, or exchange hardware 
components (hard disk, graphic card, motherboard etc.) on the license server, the 
network licenses need to be revoked (i.e. locked) before the exchange. For this, the 
following requirements need to be fulfilled: 

» Administration tools need to be installed on the License Server. 

» All licenses on the network server need to be unlocked again. Please make sure that 
no application using these network licenses is running.  

» All commuter licenses need to be checked in again.  

» The License Server (service) must be running.  

 

 The revocation must take place before the exchange of hardware components. If the 
hardware is irreparably damaged, please contact the ISD Hotline (Email: 
hotline@isdgroup.de, Phone: 0049 - 231 9793 166). 

 

Now carry out the following steps: 

 

Step 1 – Generate Revocation Password File  

To prevent the revocation of network licenses by unauthorized persons, a corresponding 
password file is required, which is generated with the help of the License Monitor tool. 
Only persons knowing the password are granted the rights for the revocation of their 
network licenses.  

To generate the password file, proceed as follows:  

» Open the ISD License Manager (x32 Server). Select Tools > License Monitor 
(WlmAdmin.exe).  
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» Select Tools > Generate Revocation Password. 

 

 

The following dialogue is displayed:  

 

» Enter the desired password (at least 8, but not more than 32 characters). 
Please do not forget this password! Without the password you cannot revoke your 
network licenses!  

» Click Generate. The program prompts you to specify the storage location for the 
password file.  

» Select a location and click Save. The password file will be saved, with the file name 
sntlpassword.dat, to the selected folder. Please note that the file name must not be 
changed. Do not forget this storage location, as the file needs to be copied to another 
folder at a later time.   
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Step 2 – Copy Password File to Working Directory of License Server  

After generating the password file sntlpassword.dat, copy the file to the installation 
directory of the license server, if you have not already selected the directory when 
saving the file.  

Default paths are as follows:  

» Windows XP 32 Bit  
<OS Drive >:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS License 
Manager\WinNT 

» Windows 7 32 Bit  
<OS Drive >:\Program Files\Common Files\SafeNet Sentinel\Sentinel RMS License 
Manager\WinNT 

» Windows 7 64 Bit  
<OS Drive >:\Program Files(x86)\Common Files\SafeNet Sentinel\Sentinel RMS 
License Manager\WinNT 

 

Step 3 – Revoke Network Licenses  

Please note that licenses can directly be revoked from a license server or from a client.  

» Start the ISD License Manager (x32 Server) tool. Open the Revoke Server License 
tab.  

» Enter the name of the server (LOCALHOST) on which you want to revoke the 
licenses. 

» Enter the port number of the license server (Default: 5093). You can use the Check 
Server button to check your entries.  

» Enter the number of the license version that you want to revoke. The version number 
can be checked in the License Monitor: Expand the Subnet Servers level containing 
the license server structure. The first number stands for the module number, the 
second number for the license version.   

» Now enter the password. If you forgot your password, please repeat steps 1 and 2.  
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» Click the Revoke network license button.  

» Select a storage location for the so-called "Revocation Ticket" file. The ISD requires 
this file for checking purposes and granting of new licenses.  

 

An appropriate message will be issued, telling you whether the revocation was 
successful or not. 
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» Finally, send the revocation ticket to the E-mail address 
license_request@isdgroup.de. 

 
Step 4 – Send Revocation Ticket File to ISD Software und Systeme GmbH 

» Send the Revocation Ticket to license_request@isdgroup.de.    

 
Step 5 – Install License Server Software on New Server Computer  

The installation of the new License Server software and the detection of the new 
hardware ID on the new license server computer can take place before, at the same 
time of or after the revocation on the old computer.  

The sending of the license file for the new Server can, however, only take place after 
receipt and verification of the revocation file for the old computer. All Server Licenses 
created after 1 August 2010 will therefore remain valid and utilisable for 4 days after 
revocation.  

 

5.4 Revoke Local License for Hardware Component Exchange 
To revoke a local license for hardware component exchange, or for the transfer to 
another computer, the following preconditions must be fulfilled:    

» The revocation must take place before the hardware component exchange. If the 
hardware is irreparably damaged, please contact the ISD Hotline (Email: 
hotline@isdgroup.de, Phone: 0049 - 231 9793 166). 

» You must be logged with administrator rights on the computer on which the 
revocation is to be performed.  

» The HiCAD and HELiOS programs on the local computer must be closed.  

 

mailto:license_request@isdgroup.de
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Step 1 – Revoke Local License 

» To revoke a local license, activate the Windows Start menu and select All programs > 
ISD Software und Systeme > Administration > License Manager (x32 Server). 
Activate the Revoke Standalone License tab.   

For operation systems with user account control please execute the program by right-
clicking and selecting As Administrator; otherwise the functionality is greyed out.  

» In the LockLicense program, the HiCAD/HELiOS License option must be activated, 
then select the appropriate option for license revocation; in the License Manager no 
further selection will be required, you can immediately click the Revoke license 
button. 

» Click the Send revocation code button to create an E-mail containing all required 
information.  

If no mail client is installed, you can also make a screenshot and send it to the ISD 
(Email: license_request@isdgroup.de; Fax:0049 - 231 9793 288). In either case please 
also provide the name of the computer on which the revocation is to be performed, as 
this will facilitate the assigning of the revocation code. 

 
Step 2 – Request License for New Computer 

At the same time you can request a new local license as described in paragraph 4.2. 

The sending of the new license file can only take place after the revocation code of the 
old hardware has been received and verified by the ISD; the revoked license will 
therefore remain valid and utilisable for 4 days after revocation.  

 

  

mailto:license_request@isdgroup.de
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6 HELiOS at a Glance 
On the way to the finished product, time expenditure, the cost situation and product 
quality can only be optimised if all departments of a company work together efficiently. 
This requires a well-structured and efficient exchange of information between the 
parties involved in the production process - from Manufacturing, Purchasing and 
Service to Marketing and Sales. 

HELiOS is a state-of-the-art PDM/PLM system providing all essential tools for an error-
free logging, management and distribution of the data required for the production 
process chain. Once saved, these data can be re-used within the entire company and 
for the complete product life cycle. HELiOS manages and controls all process cycles by 
regulating and monitoring the processing and transfer of these data. 

Thus, the know-how of the company will be used optimally, redundant work can be 
avoided and error sources will be eliminated. 

HELiOS combines Product, Process and Peripherals Management to form a single 
system, thus making HELiOS the “knowledge reservoir” of your company. 

HELiOS can be integrated in your overall CAD system or used as a stand-alone system, 
the so-called HELiOS Desktop 

Thanks to its modular structure, HELiOS can be optimally adapted to company-specific 
requirements.  
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7 First Steps 
7.1 Program Call 
Start the HELiOS Desktop by double-clicking on the HELiOS.EXE file in the \HELiOS\exe 

directory or via the program icon  on your Desktop. 

Default setting is the project-independent start. Please note that the list view in the 
right-hand window will not be shown when you start HELiOS Desktop for the first time. 
Select a project first and display the list view via View and then Lists. 

If you have not ended HELiOS correctly during your last session, you will receive an 
error message from the Vault Server. 

 

7.2 Registration 
The HELiOS User Management is based on the User Management of Windows. If 
several users are registered with the same Windows User Name in EDBSETUP, a login 
mask will appear when starting HELiOS Desktop.  

Name and active group enable the user to login with the rights guaranteed by the User 
Management.  

If you select a project from the Active Project drop-down list, this project will be opened 
after starting HELiOS Desktop. If you select the project-independent setting, all 
documents will be displayed. 

Start the HELiOS Desktop with Login (see below).  

To ensure that a specific project will be opened after starting HELiOS Desktop, you need 
to specify a Start Project. On the Ribbon, activate the Tools tab, then select Options, 
activate in the dialogue the General tab and choose a start project.  

 

mk:@MSITStore:D:\Dokumente%20und%20Einstellungen\sduempelmann.INT\Desktop\helios.chm::/AllgemeinesZuHeliosNext/Konfiguration_(EDBSETUP)/HELiOSKonfiguration.htm
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7.3 Login 
Use the Login  function for a new login while working with HELiOS Desktop, e.g. to 
work with different rights without having to exit the program.  

1. Activate the Login  function on the QuickAccess toolbar.  

2. Select a different user.  

3. Change the active project if required and confirm the new settings with Login. 
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8 How to Use the Help 
The Online Help provides you with information, descriptions and examples on all 
functions and techniques which are available in HELiOS.  

 

 Please note that the scope of available functions may vary, depending on the 
configuration level of your HELiOS product. This means that some of the functions 
described in the Online Help may not be available in your system. 
 
As of Version 2012, the Help will be available both locally (status of the installation DVD) 
and on the Internet (regularly updated) at help.isdgroup.com. Both versions of the Help 
can be called from HELiOS, via Tools > Help Topics > General. You can select your 
preferred Online Help type via Configurations > Options > Help.   
 

 
 
In order to use the Internet version of the Help, you need to register for the ISD’s new 
company Wiki once. This will not only give you access to the new Help, but also provide 
you with many other information which will be made available shortly in the ISD Wiki 
(Forum, Download area etc.). 
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Click Sign up in the login window of the Online Help to register. If you have already 
been registered, enter your access data and click Login to get directly to the start page 
of the Online Help.  
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Register for the ISD Wiki 
 
After clicking Sign up in the Login window of the Online Help, enter the data required 
for the ISD Wiki in the dialogue window. Confirm the security prompt and click the Sign 
up button. 
 

 
 
After the registration the dashboard of the ISD Wiki will be displayed. A message 
indicates whether you have been authenticated as an ISD customer.  
 
If you could be identified as an ISD customer, you can now directly launch the Online 
Help using your registration data.  
 
If you could not be identified as an ISD customer, please perform the steps described in 
the message.  
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9  What’s New in HELiOS 2012? 
Redesigned GUI and functionality: 

» Enhanced functionality for Drag & Drop behaviour (also for Folder and Project 
structures).  

 The dragging of a document from the Windows Desktop into the HELiOS Desktop 
results in an import to the HELiOS Desktop, while the source file will be retained. 
(SP2) 

 Optimised search functions and result lists 

 Optimised display and behaviour of list views and tree structures, also for project 
structures. (SP2)  

 Documents can be loaded as read-only files (via context menu) 

  When re-importing files, you can now also check in files with changed extensions 
(e.g. files changed from .doc to .docx). (SP2) 

 New Mark Up / Redlining options (SP2) 

It is generally possible to indicate in result lists whether a redlining document 
exists for a file. 

If a mark-up document exists for a .SZA file that has been opened in the HELiOS 
Desktop, you will be asked if this document should be opened.  

 

Multiple classification:  

» It is now possible to assign objects to multiple classes and lists of characteristics, 
which do not need to be hierarchically related to each other. 

 

Support of text fields with line break:  

» Text attributes can now consist of more than 255 characters and several lines if 
desired. To be able to use this feature, you need to assign the corresponding 
attributes to the required text fields (New: Unlimited text length, Line break possible).  
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Office and CAD Interfaces:  

» HELiOS 2012 offers Plug-ins for the following versions of external CAD systems:  

 Autocad 2011,  

 Inventor 2011, and  

 SolidWorks 2011  

(both 32 and 64Bit); 

As well as a permanent MS Office interface (incl. Outlook). 

» The Plug-in for SolidWorks has been enhanced. Besides, it is now possible to insert 
Standard Parts in HiCAD via the part master of the HELiOS database. (SP2) 

 

Material Manager: Transfer of User Materials:  

» The Material Manager (materialmanager.exe) that enables a taking over of materials 
from the Catalogue Editor to HELiOS, now also allows a transfer of user-defined 
materials in the Factory Standards catalogue to HELiOS. (SP1) 

 

Support of further formats in the Plot Manager:  

» In the HELiOS Desktop, documents can be converted to other formats via output to 
the Plot Manager. Besides the DXF and DWG formats, conversions to Iges, Step or 
3D-PDF file are now also possible. (SP1)  

 

Terminal Server Adjustment:  

» To ensure a smooth operation of HELiOS in a Terminal Server environment, several 
adjustments and optimisations of the system have been carried out. (SP1)  
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Internet Server:  

» The HELiOS Internet Server provides the option to access, with the help of a web 
interface, an active HELiOS database, where you can then search for and call detail 
masks for documents, parts, folders and projects as a client. (SP1) 

 

Vault-Server for several suppliers: 

» Thanks to an enhancement of the Vault Server architecture it is now possible to 
provide specific Vault Servers with particular contents via a central Vault Server. For 
more detailed information, please contact our Consulting staff. (SP2)  
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ISD Ulm 
Wilhelmstraße 25 
89073 Ulm 
Germany 
Tel. +49-(0)731-96855-0 
Fax +49-(0)731-96855-10 
 ulm@isdgroup.de 
 www.isdgroup.de 
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ISD Austria GmbH 
Hafenstraße 47-51 
4020 Linz 
Austria 
Tel. +43-(0)732-9015-1800 
Fax +43-(0)732-9015-1829 
 info@isdgroup.at 
 www.isdgroup.at 
 
ISD Benelux b.v. 
Het Zuiderkruis 33 
5215 MV ‘s-Hertogenbosch 
The Netherlands 
Tel. +31-(0)73-61538-88 
Fax +31-(0)73-61538-99 
 info@isdgroup.nl 
 www.isdgroup.nl 
 
ISD Benelux b.v. 
Blankenstein 230 – 1a 
7943 PG Meppel 
The Netherlands 
Tel. +31-(0)522-2359-80 
Fax +31-(0)522-2359-81 
 info@isdgroup.nl 
 www.isdgroup.nl 
 
ISD Schweiz AG 
Rosenweg 2 
4500 Solothurn 
Switzerland 
Tel. +41-(0)32-62413-40 
Fax +41-(0)32-62413-42 
 info@isdgroup.ch 
 www.isdgroup.ch  

 


